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A working example! 

This practical makes use of the MyProject file.  You can import it in to your MS Project version and have a look.  
Or if you feel like a challenge you can try re-creating what I have done. The screen below shows the above file 
imported in to my MS Project Pro software. 

 

Under Project – you will find information (assuming you are using the same version) and the following appears 
which shows a little information. 
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I imported an older project I had – and updated it, in as much as I wanted the dates to match current ones, not 
past ones. Play with Update Project etc. See what you can do. 

 

Note for each of the tasks, you can bring information on the resources by clicking on the Resource tab and then 
look at assigning resources. 
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You can click on the View tab and have a look at Task Usage for each of the given tasks. 
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Reports … in various forms 

Obviously we don’t just want to input information – we also want to produce reports for the boss based on how 
we are tracking.  The lectures will also mention measurements like Earned Value Management (EVM) which 
shows how we tracking both time and cost-wise. You might just initially want a Cost Overview. By looking 
under the Design tab, you can get an idea of this. 

 

Or Project Overview for how the project is generally tracking, not % of tasks complete etc. 
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The boss is often interested in the Work Overview to see how much time is remaining.  What actual work is 
complete and what remains etc. 

 

Naturally Overallocated Resources (again under the Design tab), lets us see which resources are over-allocated 
and so being overallocated - perhaps these will cost more in effort, money etc. being thrown at them to get tasks 
completed? 

 



 COMP3770/6770  Management of IT Systems and Projects 

   
 Page 7 

Resource Overview allows us to see our staff for example, or machines etc. and how these are being used.  Our 
department manager (Ms. Melina Chan) actually has to keep track of how we as staff are allocated and who is 
overloaded with teaching etc.  

 

Costs of course … every boss wants to know about these. 
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Even EVM (Earned Value Management) which I mentioned above … note we look at this in about week 4. 

 

Having looked that above, why not work through the following from a previous MS Project practical I had 
created a few years ago. Yes the screens look different because they are in an earlier version of project. 
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A brief tutorial on creating a project 

Now have a go for yourself at perhaps re-creating the same inputs as I showed above.  The following screenshots 
are from an earlier version of MS Project (who knows perhaps you are even using this one – it really doesn’t 

matter what version you use as long as it is PM software). 

Briefly the tasks are as follows. Begin by creating a new project. 

Go to Options under the Tools window and set the parameters you desire. Now depending on the version of the 
software, the tabs will differ, but have a look at the screenshots below first and then work out which version of 
the software you are using matches these? 

Again I don’t care for the assignment if you even don’t use MS Project, but use another (PM) software of your 
choosing! 

 

 

 

 

See how in the figures above I have stipulated how dates should appear and that units of measurement should be 
in months and so on.  Familiarise yourself with the sub-menus. 

Now start entering all the tasks (including sub-tasks), you should end up with a project chart that looks 
something along the following lines: 
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We now wish to create subtasks. Begin by highlighting the task you wish to have as a subtask, e.g.: 

 

And so on … 
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And now we are in a situation to start considering the how many months we would like to allocate to these 
tasks. As this is a proposal for an ARC (Australian Research Council) grant one is expected to apply a year 
before the funding becomes available, for this reason you will note the tasks begin in January 2008 (unless 
you have imported this project and updated it in the previous practical? 

At this stage, try changing the month allocation to the ‘super’ task. Note that the allocation will be greyed 
out. You need to make allocations in the subtasks and this will be reflected in the ‘super’ task. Notice how as 
you fix the parameters for the subtask the supertask will initially appear to be ‘out of sync’. By the time you 
have finished fixing the parameters you will be able to see the supertask dates should end up at the start date 
you have set for the initial subtask under that supertask, for example: 

 

Now I shall finish off the start dates.  The finish dates will be automatically calculated. Note in this instance 
that the project (ARC grant) will finish in December of 2010 (this is because funding in this case is for a 3 
year cycle). 

Now you will notice once you have finished and scrolled along to the start of 2008 (to show the gantt chart, 
you can’t see this all on one screen: 
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To that end use the magnifying glass zoom in/zoom out tool  on the top menu bar and click on your 
right hand window to zoom the gantt chart out. 

Reposition your windows so that you can see all of the items of relevance on your screen, like so: 

 

Now we should really consider whether some tasks are likely to be predecessors of others. The reason this is 
important is that we need to know if we really have to finish one task before we start another. In the case of 
the grant we have used as an example of MS project, quite a few of the tasks overlap. However some tasks 
could nevertheless be considered predecessors of some others. Here is what the chart would look like if I 
added in predecessor tasks. For example subtask 1c has a predecessor task: (2 Task 1a Literature review), in 
other words the subtask in this case listed on line 2 and so on. 
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If you expand the left hand window you will 
note the second column shows an indicator 
field. These indicators basically provide you 
with ready reference information for any given 
task. You will note indicators for only the 
subtasks are provided. 

. 

 

By this stage, having set up a number of tasks, we can start to examine some of the screens of relevance.  If 
you double click on any task the following set of tab menus appear, beginning with General, followed by 
Predecessors, Resources, Advanced, Notes and Custom Panels. 

 

 

General 

 

Predecessors 
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Resources 

 

Advanced 

 

Notes 

 

Custom Fields 

 

Let us add some information where necessary. Click on the first subtask 1a, beginning with the General 
field, click on the estimated box. You will note MS Project adds a question mark to this value. Click okay 
and when you are returned to the main screen you will note the relevant changes have been made to the 
subtask itself. Go back and unclick (there is no real need here to be uncertain about our task duration, 9 
months is long enough to conduct our literature review. While we are here play with the Hide task bar and 
Roll up Gantt bar to summary boxes and see what MS Project does. 

With regard to the Predecessor field, we have already added some predecessors where necessary, for 
example double click on task 1c and the Predecessor window will appear for that task. Add a lag of 1 month 
to this subtask.  See what MS Project does. 

Resources we will deal with shortly, the Notes field is quite straightforward, so that leaves us with the 
Advanced and Custom Fields menus. 

Allocation of resources 

Resources are either the people, materials or equipment needed to undertake tasks. 

We should consider the resources we need to allocate to a particular task. For example let us go back to task 
1a our Literature review. As you know performing such an operation is typically time-consuming. Let us 
allocate some resources to the task.  We can go to Tools, then Assign Resources. We can double click on a 
particular subtask and in this case assign personnel. I have allocated Peter to this task 100 and demanded that 



 COMP3770/6770  Management of IT Systems and Projects 

   
 Page 15 

he perform the task. Sally I have requested she be allocated on a 50% (of her time) basis. Note when you 
extend with the menu option with the + sign, a number of other features become available. Click on Add 

Resources and see what this does. 

 

  

Let us take a little detour at this stage.  On the left hand side of your screen you will be able to click on the 
Resource Sheet option that was pointed out in section relating to the side menus. 

You should see a menu along the following lines appear. What I have done in this instance is add some 
values of my own, for example, a number of personnel and three PCs to help us with conducting the research 
outlined in the grant proposal. In a nutshell MS Project permits two types of resources either people (Work) 
or other things (Material). 

 

Note I have also added details for the workgroup my available staff belong to, what percentage of their 
time they are available to work on my project, their rates of pay, overtime rate. You will note only Sally 
and Meredith have overtime opportunities, the rest of the employees are salary earners, so their hourly rates 
are calculated on the basis of a 35 hour working week. 

I have also gone and set up their standard working hours. 
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So Sally (and all others) for example, works a ‘standard’ day rather than shift or a 24 hour day! Simply 
double click on each individual resource in the screen above and you will be able to fill in the details.  See 
how I have stipulated that the work day starts at 9am and finishes at 6pm and so on. 

You will also note that the cost per use (Cost/Use) is $0.00 for personnel, but I have factored in $5.00 per 
use for the PCs as a means of calculating some sort of depreciation on the equipment. 

Allocation of resources 

We should now allocate personnel and equipment to the task at hand!  Click on the first subtask ‘Task 1a Lit. 
Review’. Then under Tools you will find the Assign Resources submenu. Click on the + sign to see all the 
possible options.  Have a play to discover what the Add Resources option does. 

 

For the lit review part of our project we would like to assign Peter and Paul to the task (hint keep your finger 
on the Ctrl key to select both at once). 

Keep allocating personnel and equipment to the tasks along the following lines (you will note people have 
been allocated according to their strengths): 
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Hint, at this stage make sure you remove all tasks numbering > 19.  Note in the figure relevant to comment 
26 how there are a number of tasks 20 and above.  This adds confusion to MS Project.  Simply remove all 
task numbers that are not actually tasks (the reason for this is that there may be hidden calculations in these 
‘phantom’ tasks, which can upset the ‘real’ tasks you have created. 

Incorporation of milestones 

Now we should ideally add some milestones to our project to indicate the critical areas that we need to be 
aware of.  It is all very well to spend one’s time reading but we need to retrieve data. We need a 
questionnaire. Click on subtask 1d, select Advanced and mark this subtask as a milestone, like so: 

 

Similarly mark subtasks 2a, 2b, 3a, 3b and 3c as milestones. 

Allocations 

At this stage, let us examine the allocation of our staff members. Click on the Resource Graph on the left of 
the screen. You will note quite a few of our staff (by way of scrolling up and down) are over-allocated. 
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Sally 

 

Paul 
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For example Sally appears to be over-allocated by about 60% in the second half of 2008.  Other than that 
her workload is fine. Meredith is in a similar situation. Paul is over-allocated by 50% in the first and second 
half of 2009 and the second half of 2010.  If this isn’t bad enough he is over-allocated by basically 100% in 
the first half of 2010. Examine the others. 

Double click on the bar and the following screen should appear. This is not a particularly important feature 
of MS Project, nevertheless it will allow you to format graphs for reports you may have to do etc. 

 

Clearly the allocation situation is unsatisfactory and we need to remedy it.  We have a number of options 
available to us.  

we can add more staff to our project;   

we can spread the number of staff we have more effectively over the timeframe or; 

we can reprioritize our staff workloads so that we selfishly expect them to work only on our project, 
rather than anybody else’s! 

Now double click on the individual  rather than the bar, and their resource information comes up 
again. What should we do?  I think we have been overambitious with what we have given our staff to do.  
Starting with Sally, let’s reduce her workload. The main problem with her is that she is over-allocated in the 
second half of 2008. Other than that her allocation in fine. Click back on the gantt chart option and let us 
change her workload. In this case I’ve reduced her workload down to 20%. When going back to the 
resource graph her workload now looks like the following: 
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Another way we can do things is to use leveling.  Read what MS Project has to say on the issue of leveling. 

Under Tools, you will find Level Resources, like so: 

 

I have decided to choose automatic leveling. Note the Level entire project is selected and MS Project does 
recognise the project takes place from Jan 1st 2008 through to Dec 10th 2010. Click on OK and see what 
happens. Go back to the Gantt Chart option. Notice what has happened to your timeline. 

 

This is obviously no good! Now the project has slipped through to the second half of 2012! Close the MS 
Project software without saving at this particular step!  Now re-open your project again. 
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Try a number of different options for leveling …  In the end they seem to level on the basis of move 
workload allocations backward.  We still end up going beyond our 2010 deadline. This may be acceptable 
for some projects, but not here in the case of our grant expenditure. 

We can go back and perform manually add extra staff or increase the workload % we expect or our staff.  
Alternatively you may find you have to add extra staff to the project. 

I don’t have more to add at this point. This has been an introduction to MS Project.  Feel free to play with it 
further. 


